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Abstract

The IEEFE 802.11 standard defines two operational modes for WLANSs: infrastructure-
based and infrastructureless or ad hoc. A wireless ad hoc network comprises of nodes that
communicate with each other without the help of any centralized control. Ad hoc implies
that the network does not rely on a pre-existing infrastructure but rather each node partic-
ipates in routing by forwarding data for other nodes. The decentralized nature improves
the scalability of wireless ad hoc network as compared to wireless managed networks.
Each node acts as either a host or router. A node that is within the transmission range
of any other node can establish a link with the later and becomes its immediate neighbour.
However, the nodes in the ad hoc networks are constrained with limited resources and
computation capability. So it may not be possible for a node to serve more number of
neighbours at some instant of time. This enforces a node to remain connected or dis-
connected with few of its existing neighbours supporting the dynamic restructuring of the
network. The presence of dynamic and adaptive routing protocol enables ad hoc networks
to be formed quickly.

The Dynamic Transmission Range Adjustment Protocol (DTRAP) provides a mechanism
for adjusting transmission range of the ad hoc nodes. They maintain a threshold number
of registered neighbours based on their available resources. The node protects its neigh-
bourhood relationship during data communication by controlling its transmisston range.
It registers or de-registers a communicating node as its neighbour by dynamically varying
the transmission range. However a node has a mazimum limit on its transmission range.
If the distance between the mode and its meighbour is less than the transmission range
and;

1)if the number of neighbours of a node falls short of threshold value, the node dynam-
ically increases its transmission range in steps until it is ensured of an optimal number
of neighbours

2)if the number of neighbours of a node exceeds the threshold value, the node dynami-
cally decreases its transmission range in steps until it is ensured of an optimal number
of meighbours.

Coloured Petri nets (CP-nets) is the modelling language tool used for systems having



communication, synchronisation and resource sharing as significant aspects. It provides
a framework for the design, specification, validation, and verification of systems. It de-
scribes the states in which the system may be in and the transition between these states.
The CPN combines Petri nets and programming languages. Petri nets amalgamate the
use of graphical notation and the semantical foundation for modelling in systems. The
functional programming language standard ML provides the primitives for the definition
of data types and manipulation of data values. Besides providing the strength of a graph-
ical modelling language, CP-nets are theoretically well-founded and versatile enough to

be used in practice for systems of the size and complezity of industrial projects.
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IEEE- Institute of Electrical and Electronics Engineers
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Chapter 1

1 INTRODUCTION

The IEEE 802.11 standard defines two basic modes of operation for wireless LANs- infrastructure-
based and infrastructure-less or ad-hoc. In an infrastructure-based wireless network, the nodes
communicate through an access point that serves as a bridge to a wired-network infrastructure.
However, we can have peer-to-peer communication in an infrastructure-less network. Ad-hoc

is a Latin word, which means ”for this or for this only.”

1.1 AD HOC NETWORKS

An ad-hoc network is a decentralized type of wireless network which does not depend on any
pre-existing infrastructure for its operation

In an ad-hoc network, the computers (nodes) communicate to forward packets for one another
over a multi-hop network. The nodes may be mobile in an ad-hoc network .Due to this, the
radio propagation conditions constantly vary, thereby creating a dynamic scenario. Ad-hoc
networks find wide applications in cases where there is no infrastructure in the environment,
or where the infrastructure cannot be established due to cost and security issues, or it has
been destroyed or damaged.

With the significant advances achieved in the field of wireless communication in the past
decade, the ad-hoc networks concept has attained a broader scope, referring to a wide diver-
sity of wireless autonomous networks designed and deployed for various purposes like wireless
sensor networks, vehicular networks, home networks and so on. Such networks are subject
to fragile multi-hop relay paths, dynamically changing sporadic connections, distributed au-
tonomous operations and communication that is highly prone to errors.

The IEEE 802.11 defines similar modes of operation for both infrastructure-based and ad-hoc

networks. The use of the ad-hoc mode has an impact on the protocols implemented, and there



is no effect on the physical layers (i.e., 802.11a and 802.11b).In the MAC layer, the handling
of frames and the carrier-sensing responsibilities are quite the same in the modes. However,
due to the absence of access-points in the ad-hoc mode, more of the MAC layer tasks must
be taken up by the ad-hoc wireless LAN. Some of the factors that favour the use of ad-hoc
network include:

1)Cost savings: cost-saving is a major concern. It is economical as it avoids the need to
purchase or install access points.

2)Rapid setup time: Only the installation of radio NICs is needed in the user devices for
communication. Thus, the set-up time required is much less as compared to an infrastructure
wireless LAN.

However, some factors that must be considered while opting for ad-hoc mode include:-
3)Performance: The performance of an ad-hoc network is quite debatable. Performance can
be considered to be better since there is no need for packets to travel through an access point.
However, it is true for a moderate number of users. For a network involving large number of
users, contention for the channel may arise and a large number of collisions may occur [6].

4) Network Access:Absence of a distributed system does not enable users to have effective
access to the Internet and other wired network services. Even though a system can be setup
with a radio NIC and configured with a connection to the internet, this would not cater to a
large number of users. Thus, ad-hoc mode might be unsuitable for large enterprise systems
where there is a frequent need to access applications and servers on a wired network.

5) Network Management: This is a onerous task in case of an ad-hoc network due to the
varying network topology and its decentralized structure. Monitoring performance or security
audits can be applied at the access points, which are absent. Network management has to be
done at the user device level, which involves a significant overhead and is not feasible in case

of large enterprise applications.



1.2 COLOURED PETRINETS

Various dynamic and adaptive routing algorithms are needed for an ad-hoc network. To
validate such protocols, Coloured Petrinets serves are as an efficient modeling and validation
tool. It is a discrete event-modeling language combining Petrinets and Standard ML. CPN
models of a system can be built to represent the various states the system is in and the
transitions that cause a change of state. Using CPN tools, simulations are run to investigate
the behavior and verify its properties. A license for this tool can be obtained free of charge
for individual as well as for commercial uses. The CPN modeling language is regarded as a
general purpose modeling language, that is aimed towards modelling various classes of systems
in different application domains like communication protocols, data networks, distributed
algorithms and embedded systems. The simulations aid in investigating different scenarios
validating them. These simulations can also be interactively run. CPN models can be applied

to a wide variety of systems and are found suitable for systems of various size and complexity.

1.3 ORGANIZATION

This thesis is organised into various chapters. The Chapter 2 gives a brief overview of Mobile
Ad Hoc Networks (MANETS) and highlights their salient features. The second part of this
chapter describes about some of the features of the Coloured Petrinet Tool. In Chapter 3, the
topology control in MANETS is explained and the Dynamic Transmission Range Adjustment
Protocol is presented. In Chapter 4, validation of the current routing protocol is done using

CPN and the simulation results are presented. Chapter 5 concludes the thesis.
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Chapter 2

2 LITERATURE REVIEW

2.1 MOBILE AD HOC NETWORK
2.1.1 INTRODUCTION

A Mobile Ad hoc network (MANET) is a wireless network where the mobile nodes communi-
cate over radio frequencies. The network has a decentralized architecture and does not rely on
any previous infrastructure. With the advent of MANETS, a new art in the field of network
management was discovered which enabled a network to be designed without being heavily
dependent of the infrastructure establishment, as was the case in case of traditional network
designs.

Mobile wireless networks vary from fixed networks over numerous operational factors like:

- Nominally lower capacity is available in mobile wireless networks as compared to the wired
network.

-Dynamic changes in the network topology.

-Potentially higher delays and jitter.

-Greater chances of channel interference and congestion detection problems.

-Higher loss rates

-The lack of physical control leads to lack of physical security over media [1].

The nodes in a mobile ad hoc network are constantly in motion thereby leading to varia-
tions in the network topology. As a result, the Quality of Service (QoS) of the network is likely
to be affected unless specialized schemes are developed to handle such dynamic networks. The
nodes are the transmitting stations and are limited by a transmission range, so in most cases
a direct communication between the source and receiver is not facilitated. To solve this issue,
the nodes communicate in a multi-hop fashion to relay packets from the source to the desti-

nation. Therefore, the nodes function as both hosts and routers. This enables communication



between nodes even when they are not in the transmission range of one another. Due to the
decentralized nature of the network, it is not possible for a node to know the entire state of
the network. So, the nodes frequently transmit messages to get updated about the network.
Moreover, the motion of the nodes results in disruption of the links as they may frequently go
out of the transmission range, thereby hampering routing in MANETS.

The MANET network interfaces differ from conventional wired network interfaces based on
various scenario-dependent factors like:-

-Relative motion of the neighbours resulting in environmental and distance effects

-Dynamic local noise and interference caused by the nodes itself

-Links established between the nodes are often asymmetric in nature

-Time varying communication channels

-Lower layer wireless protocol behaviours

Attached
Hosts/Networks

Wireless Interface

Y

Wireless Interface k

Y

1

MANET
NODE $

A: SIMPLE MANET NODE Second Wireless Interface

MANET
NODE

- Single wireless IP interface B: MULTIPLE INTERFACE MANET NODE
* No attached local networks

* Multiple IP interfaces (wireless or wired)
* MANET routing supports attached
local networks and hosts

Figure 1: Types of MANET configurations



2.1.2 ROUTING APPROACHES IN MANET

Since the MANET neighbour interfaces behave quite differently from the conventional wired
network interfaces. Therefore, the conventional routing protocols are insufficient to handling
routing decisions in case of MANETSs and new protocols that cater to the requirements while
simultaneously considering the node-constraints have been developed. Routing in MANETS
is a dynamic optimization task aimed at providing an optimal path in terms of some criterion
and also satisfying some constraints like limited power, transmission range, etc. Therefore,
based on when the routing tables are built MANET routing algorithms are categorised as:-
1)Proactive algorithms: Each node in the network maintains a route to every other node
at all times, even if they are not needed.They are useful when there are a large number of
data sessions in the network [1].

2)Reactive algorithms: These are also called as on-demand routing techniques. Routes to
destinations are discovered only when they are actually needed.

3) Hybrid algorithms: They exhibit reactive and proactive behaviour depending on the
circumstances. They maintain routes to nearby nodes even if they are not needed and main-
tain routes to far away nodes only when needed [2].

Since the nodes are characterized by limited resources and channel bandwidth, high error
rates and frequently varying network topology, certain considerations must be taken before
designing routing protocols for such networks.

The typical design goals for routing protocols in MANETS include:-

-Minimal control overhead- the number of control messages transmitted between the devices
should be restricted to a minimum threshold since both transmission and reception consume
battery power.

-Minimal processing overhead- protocols should be so designed to incur minimal overhead for
processing cycles and rather preserve the battery power and other resources for user-oriented
tasks.

-Multihop routing-Due to limited transmission range of devices, the sender and receiver are

not in direct link often. In such cases, the packet relay is done in a multi-hop manner.



-Dynamically changing topology-The constant motion of the nodes leads to breakage of the
links between the nodes which must be handled quickly with minimum overheads.
-Prevention of occurrence of loops- Presence of loops in the network consumes unnecessary
resources and the packets are transmitted multiple times within it until the time to live(TTL)
of the packets reaches zero or the path is eliminated.

Hence, presence of loops are detrimental to the network and must be avoided.

2.1.3 THE PROTOCOL STACK

This section describes about the protocol stack in case of MANETS. It also depicts the pro-

tocol stack of various other models like the OSI and the TCP/IP model.

APPLICATION

PRESENTATION APPLICATION APPLICATION
SESSION

TRANSPORT TRANSPORT TRANSPORT
NETWORK NETWORK NETWORK :(D)H(T]Iil 6
DATALINK DATALINK DATALINK
PHYSICAL PHYSICAL PHYSICAL

Figure 2: Network Models

The OSI model has 7 layers with a defined functionality for each layer to facilitate commu-
nication between all types of systems. The OSI model is diagrammatically depicted in Fig
2.The TCP/IP model is basically a protocol-oriented model. It has 5 layers. The application,
presentation and the session layers of the OSI model are merged to form the application layer

in this model. However, the rest of the layers are similar in both the models.
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The MANET protocol stack is quite similar to the TCP/IP protocol stack except for the net-
work layer. The network layer is divided into two parts- network and ad hoc routing. Since
the nodes in a MANET can act as both hosts and routers, the implement an ad-hoc rout-
ing protocol to relay packets. The network part uses the IP protocol where the ad hoc part
uses various other protocols specifically designed for ad hoc networks. The lower layers, the

datalink and the physical layer implement protocol designed for wireless communication.

2.1.4 APPLICATIONS

MANETS find enormous applications in case of emergency rescue operations, disaster relief
efforts, low enforcements and military operations. MANET technology is also widely used to
provide a wireless routing region at the edge of the Internet. This helps to extend the range

of the network and provide robust adaptation to infrastructure dynamics.

—

C Internet
Cloud ™

Wired Router

Figure 9.4. Basic MANET Internet extension.

Figure 3: Basic MANET Internet extension
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2.2 COLOURED PETRINET
2.2.1 INTRODUCTION

Coloured Petri nets (CP-nets or CPNs) is a language used for modelling and validation of
systems having concurrency, communication and synchronization as vital aspects [4]. They
provide a framework for the design, specification, validation and verification of systems [5].
CP-nets is used to model discrete-event systems.CPN is a combination of Petri nets and Stan-
dard ML. Standard ML is a functional programming language that provides primitives for
defining data types and for their manipulation, describing how data can be manipulated and
for the creation of compact and parameterisable models [4].

A CPN model describes the various states the system is in at different points of time. It
also specifies the events (transitions) that cause the system to change its state. By making
simulations, the system design can be investigated, the different scenarios it can possibly be
explored and the behaviour of the model can be tested therein. Also, it is possible to verify the
properties of the system by state-space methods and a simulation-based performance analysis
can be generated. The users can interact with the CPN tool by direct manipulation of the
graphical representation using user-interaction techniques like the tool palette and marking
menus [6].

CPN models are structured into a set of modules for handling large specifications.As in pro-
gramming languages, here too the modules can interact with one another with the help of
well-designed interfaces. The modular concept of CP-nets, based on a hierarchical structur-
ing mechanism, allows a module to have sub modules and allowing a set of modules to be
composed to form a new module.The time concept adds vitality to the modelled systems by
indicating the timeelapsed in execution of events.

The CPN models are formal in nature. This means that the modelling language has a well-
specified mathematical definition of its syntax and semantics. Therefore, such models can be
constructed to verify the system properties, to check if the system meets the desired proper-
ties, and certain undesired functionality have not been mistakably introduced into the system.

This verification of the system properties is facilitated by state-space methods. The basis

11



underlying this technique of validation lies in computing all the reachable states of the system
and the corresponding state changes. The details of these are represented as a directed graph
with the nodes depicting the states, and the occurring events are indicated by arcs. State
spaces can be constructed fully automatically. The results at each step of simulation can be

observed directly in the graphical representation of the model [4].

2.2.2 MODELLING OF STATES

Unlike most specification languages, CPN models are both state and action oriented at the
same time and thereby provide an explicit explanation of both. This enables the modeller to
determine on which to focus at a given point of time, the states or the actions.

The basic constructs of the CPN model are:

1)Places: These are ellipses or circles and indicate the states of the system

2)Types: Each place is associated with a type, also called as a colour-set. These indicate
the type of data a place can hold, very similar to that in programming languages. These
colour-sets can be combined in any fashion to form arbitrarily complex patterns.
3)Transitions: These are represented by rectangles. The names of transitions are written
inside these rectangles. The actions of the system are represented by means of transitions. An
action of a CP-net consists of one or more transitions occurring concurrently.

4)Markings: They indicate the state of the system. Marking refers to the tokens positioned
over the individual places. Tokens refers to the data value(colour) present at the place. The
colour-sets are synonymous to the data-types and the colours are synonymous to the data-
values. The token values belong to the type of the place on which the token resides. The
marking can be a multi-set of token values, which are several appearances of the same element.
5)Initial Marking: A CP-net has a distinguished marking called the initial marking, which is
used to describe the initial state of the system. The initial marking of a place is, by convention,
written on the upper left or right of the place.

4)Arcs and Arc Expressions: Arcs are used to connect transitions and places. The actions

12



are basically firing of transitions. An occurrence of a transition transfers the tokens from input
places(places connected to incoming arcs ) to the output places (places connected to outgoing
arcs). Thus, the marking of the CP-net changes. This is known as the token game. The
number of tokens added and removed by the transition, and their corresponding changes in
the data-values are decided by the expressions, which are positioned next to the arcs.

A transition can be enabled only when the two criteria are satisfied:-

1)All the arc expressions must evaluate to the tokens which are present on the corresponding
places connected to the incoming arc.

2)The guard conditions must be satisfied, if any.

The values of the token that removed from the input places of an enabled transition depends
on the input arc expressions and similarly, the values of the tokens transferred to the output
places depends on the output arc expressions.

Places and transitions are referred to as nodes. Nodes along with the directed arcs constitute
the net structure. An arc always connects a place to a transition or a transition to a place.
However, two transitions or two places cannot be connected directly by arcs. A number of
tokens along with the token colours on the individual places are representative of the state of
the system and is called a marking of the CPN model. On the other hand, the tokens on a

specific place form the marking of that place [5].

2.2.3 CONSTRUCTION OF HIERARCHICAL MODELS

The concept of hierarchical CP-nets allows the modeller to construct a large model by an
aggregation of a number of small CP-nets. These small CP-nets are called pages and they are
related to each other in a well-defined manner. It is possible to relate a transition along with
its connected input places and arcs on a page to a more precise and explicated version of the
intended activity on a separate page.

Substitution transitions are used to implement the hierarchy concept. They are replaced by
subpages which contain the detailed description of the activity represented by the correspond-

ing substitution transition. The subpages have a number of places marked with an In-tag,
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Out-tag, or I/O-tag. These places are called port places. They provide an interface through
which the subpage communicates with its surroundings. The input port enables a place to
receive a token from its surroundings. It is marked with an In-tag. The Out-tag represents
the output port through which data values are sent from the place to the surroundings. Places
marked with an I/O-tag can act as both input as well as output places. The port places of
the subpage must be assigned to the socket places in the main page in-order to specify the
relationship between a substitution transition and the subpage. This is referred to as the port-
socket assignment [4]. The Hierarchy palette provided by the GUI helps in the construction
of hierarchical models. The steps to construct a hierarchical model are:-

1) Move a transition or group to a new submodule.

2) Replace a substitution transition with its submodule.

3) Assign a submodule to a substitution transition.

4) Assign a port to a socket.

5) Set port type to input.

6) Set port type to output.

7) Set port type to input/output.

8) Assign a place to a fusion set [4].

There are two methods for implementing hierarchy in CPN models:

1) top-down construction

2) bottom-up construction

Top-Down Approach:- The Move to Submodule tool finds its application here. A sub-
stitution transition is first created in the original module with the appropriate arcs. The port
places are specified in the subpages and they are linked to the substitution transition page by
means of the corresponding socket assignment.

Bottom-Up Approach:- The Assign Submodule tool supports a bottom-up approach. In
this case, existing modules are first created and then, they are assigned as submodules to a

substitution transition. Port-socket assignment is done automatically wherever possible.

14



Apart from these, the Clone tool helps to clone hierarchy elements including the substitution

transitions, port-types, tags, and even all the sub-modules.

2.2.4 SYNTAX CHECK AND CODE GENERATION

CPN Tools performs syntax and type checking, and simulation code generation. Error mes-
sages are easy to interpret and are indicated to the user in a contextual manner near the object
causing the error [4]. The processes of syntax checking and code generation are incremental in
nature. They aare parallel performed with editing. This makes it possible to execute separate
parts of a CPN model even though the entire model is not yet constructed. It also facilitates
in unit testing, that is when individual parts of a CPN model are modified, the syntax check
and code generation can be only performed on the elements that are interdependent with the
modified parts. Also, the checking of some elements is postponed until they have enough infor-
mation to be checked if they are syntactically correct or not. For example, a place without its
colour set inscription is not checked, or a transition is not checked until all of its surrounding
places are checked, and all its surrounding arcs have the corresponding arc inscriptions [4].
When a simulation is run, the following is the simulation feedback shown:

1) Current markings of places are indicated near the individual places.

2) The number of tokens currently present at a place is given by a green circle.

3)The corresponding token values at the places are shown in green boxes.

4)Green auras are present around enabled transitions.

5) Green underlines are shown on the pages with enabled transitions.

6) The step count and time taken is shown in the index for the net under simulation. [7] The
main outcome of the code generation phase is the generation of the simulation code. The
simulation code contains the functions for inferring the set of enabled binding elements in a
given marking of the CPN model, and for computing the marking reached after an enabled

binding element occurs [4].
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Chapter 3

3 TOPOLOGY CONTROL IN MANETS

3.1 INTRODUCTION

The network topology is determined by the links between the nodes that is used by the rout-
ing mechanism. MANETS are indeterministic in nature and the topology of the network is
dependent on a number of factors like mobility of the nodes, their battery power , the traffic
patterns in the network, noise, interference and transmission power of nodes. However, these
factors are subject to changes depending on the current state of the network and its present
demands.

The network size, referring to the number of nodes in the network and their distribution has
an effect on the performance of the network. A sparse network may have numerous network
partitions and the entire network may be divided into disconnected portions. Thereby, the
connectivity is hampered and it may result in lack of routes for packet transmission. On the
other hand, dense networks may have problems like congestion and contention for bandwidth
leading to a low packet delivery ratio. More number of collisions are also caused and thereby
more energy is expended in overcoming these.

However, the network size and density are invariable parameters and hence cannot be changed.
Moreover, the nodes are constantly in motion, making it all the more difficult to predict the
distribution patterns. The focus is to implement adequate routing protocols to minimize the
overheads incurred due to the variability in MANET topology. This is essential as the topol-
ogy has a huge impact on the performance of the network and in making routing decisions.
Hence, the network topology must be controlled adequately.

Topology control includes maintaining network connectivity, increasing throughput, reducing
interference, ameliorating energy efficiency. This is basically done by manipulating the
parameters of the node so as to attain a particular network topology. This process of param-

eter adjustment is a controlled loop, involving a dynamic system, failing which, may lead
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to the instability of the network. Topology control is done to improve the performance of the
routing protocol [7].

One such adjustable parameter of nodes is its transmission range. If the transmission range
of a node is very high, it is likely to have many neighbors (nodes within its transmission
range), hence a higher degree. This leads to lower average hop-length but, more contention
for bandwidth. On the contrary, if the transmission range is very low, the nodes will more
likely have a lower degree (less neighbors). This could be similar to the case of having a spatial
network where the entire network is divided into disconnected portions, leading to a scarcity
of routes. In such a case, an optimal number of neighbors must be kept by a node so as to
ensure a desired performance is delivered by the network. Thus, the transmission range could
be adequately varied to satisfy this criterion of maintaining and optimal neighbor count for
the nodes in an ad-hoc network. Studies have shown that the optimal number of neighbours
for each node in a stationary network, is six and the transmission radius should be adjusted

accordingly to allow each node to maintain this node degree [7].

3.2 DYNAMIC TRANSMISSION RANGE ADJUSTMENT PRO-

TOCOL

The basic assumption in an ad-hoc network is, two nodes willing to communicate may be
outside the wireless transmission range of each other but can communicate in multiple hops,
provided other nodes in the network are willing to forward packets. However, there may be
a disruption in the working of an ad-hoc network, if an intermediate node, participating in a
communication moves out of the fixed transmission range. So the nodes must be capable of
dynamic reconfiguration by self-adjusting the variable transmission range. A low transmission
range may result in a sparse network and the connectivity among nodes may not be effec-
tive. On the contrary, a high transmission range will ensure connectivity but collision and
congestion of control packets will increase, which may significantly increase the end-to-end

delay.In an operating area, when there are fixed number of nodes distributed uniformly, the
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optimality in transmission range is essential. Thus, a variable transmission range protocol like
the Dynamic Transmission Range Adjustment Protocol (DTRAP) would be highly effective
in such a dynamic environment [5].

The Dynamic Transmission Range Adjustment Protocol provides a mechanism for adjusting
the transmission range of the ad hoc nodes. The nodes are configured to maintain a threshold
number of neighbours based on their available resources. The nodes protect their neighbour-
hood relationship during data communication by controlling their transmission range. It can
register or de-register a node as its neighbour by dynamically varying its transmission range
in steps. However, there is a maximum limit of the transmission range. It can register or
de-register a node as its neighbour by dynamically varying its transmission range in steps.
However, there is a maximum limit of the transmission range beyond which it cannot be in-
creased. If the separating distance between the nodes is less than the maximum transmission
range and;

1)if the number of neighbours of a node is less than the threshold value, the node dynamically
increases its transmission range in steps until it is ensured of an optimal number of neighbours.
2)if the number of neighbours of a node exceeds the threshold value, the node dynamically de-

creases its transmission range in steps until it is ensured of an optimal number of neighbour [5].
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Chapter 4

4 DESIGN AND VALIDATION

4.1 INTRODUCTION

In the field of multi-hop wireless network, it is almost inevitable for any design to overcome the
disturbance in communication process and also a design which allows us to control the packet
congestion in a dynamic field, which in turn reduces delay in end-to-end communication. The
self adjustable transmission protocol, which forms a part of DTRAP is an efficient protocol
with regards to the ad hoc network.

Our work is based on two significant phases:

1)Design and modelling the ad hoc network using CPN.

2)Validate the above model for the Dynamic Transmission Range Adjustment Protocol using

CPN.

4.2 INSTALLATION

The CPN tool software was downloaded from the Aarhus University site which provides license
for the use of this tool. On downloading the set up file, it was successfully installed alongwith
its component files.

As a start up the help page is referred to get used to the different options and components of

of this tool.

4.3 DESIGN AND MODELLING
4.3.1 INITIAL MODELS

To get used to the know-how of this tool, first a preliminary task was taken up to validate a

scenario where a node sends its coordinate values and it gets updated on firing a transition.
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Thereafter another subsequent model was designed wherein the two nodes were taken in the
scenario and the square of their geometrical distance was calculated.

To get acquainted with the hierarchy, an hierarchical model was also designed.

4.3.2 ESTABLISHING LINK BY FINDING NEIGHBOURS

This forms the core part of our project where in we have taken five static nodes in an ad hoc
network. These five nodes share a common message store MsgStore. The page MsgStore
shows the five nodes and their messages being sent to the MsgStore.

The nodes in the main page MsgStore then form a hierarchy being replaced by a subpage

Binder 0
AH(1) 'AH(2) AH(2) AH(4) AH(S) MsgStore

Figure 4: Model of five nodes communicating

which portrays the establishing of link of each node with its neighbours.

The subpage AH(3) demonstrates the neighbour node determination. Here the parameters
of the node such as its co-ordinates, battery power, mobility and counter (which keeps a note
of its number neighbour, initialized as zero) is broadcast to the MsgStore.

The appropriate or intended node retrieves the MSG from the MsgStore.
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FPCPN Tools (Version 220 - Sep
»Tool box
»Help
» Options
¥ works.cpn
Step: 0
Time: 0
» Options
» History
¥ Declarations
¥ colset [NT=int;
¥var ctr,n,cl:INT;
rvaltr=31;
¥ colset POSITION:
¥var crd:POSITION
¥ colset BOOL=haod
¥var b:BOOL;
¥val NoOfNodes=1
¥ colset NODES=in|
¥ colset Msg=recor
¥var MSG:Msg;
¥var s,r:NODES;
¥ colset STRING=st
Tval A=1" AH(2)++
val B=1"AH(1)++
val C=1"AH[1)++
val D=1"AH[2)++
val E=1" AH(2)++
fun GetDistance(|
fun Update_Cnt{l
fun ChkThreshale
fun ChkThreshale
fun ChkThreshale
» Monitors
¥ MsgStaore
wAH(2)
> AH(E)
TAH(4)
inc_4
der_4
TAH(S)
inc_5
der_ 5
»AH(1)

Binder 0

[step()>70]

None

DISTANCE CALCULATION: CalculateDistance transition is fed with the senders
and the receivers co-ordinates. On firing this transition it calculates the distance between

them. If the distance is within a specified transmission range then it returns a Boolean yes

else no.

fun GetDistance(k:INT LINT p:INT,q:INT)=if (((k-p)*(k-p)+(l-q)*(1-q))<961) then yes else

1n0;

COUNTER INCREMENT: IncrememntCounter is fed with the previous step counter

value and the boolean returned by CalculateDistance. So initially it is fed with zero. When-

MsgStore  AH(3) (AH(4) AH(5) inc_1  der_1

Gl el Difnret ozl TGl =) Bifarel =) Dilatel cb Pefde 28 Bilaiel 50 Fifae =5 TAEGET TR

BroadCast]

{se=s,re=rtrange=tr,bp=n,cnt=ctr,mb=Il,xc=(#lcrd),yc=(#2crd) }
LN

C |1 AH[1)++

1°AH(2)++

DestNode 4 1" AH(4)++
ool AH(S)

GetDistance(#xc MSG,#yc MSG, #1 crd,#2 crd)

Increment_|
Counter

ReceivedMsg
Msg

Figure 5: Extensive view of node 3

ever is the boolean is yes, the counter gets incremented byl.

fun Update_Cnt(m:BOOL)=if(m=yes) then 1 else 0;

c+Update_Cnt(b);

The place CntNei keeps a track of the counter value for each and every node.
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4.4 VALIDATION OF DTRAP USING CPN

TRANS: We use a transition Trans which is fed with updated final counter value. This
transition is fired only when the no. of steps is greater than the no. of steps taken so that
no token value is left behind at any place. Here we use the control flow concept. We only
take the counter value when it has reached to the end of execution leading to no leaving
behind of tokens in any of the places in the model. The advantage of using such control flow
mechanism is: The place CountNei acts as a store and the value stored in this place can be

used subsequently in the DTRAP validation.

4.4.1 TRANSMISSION RANGE ADJUSTMENT

The output of the Trans is fed to a place, new_count which is the node parameter as speci-
fied earlier. This dynamic counter keeps the updated value of the count of number of nodes.
This updated c is passed to two substitution transitions:

1)inc

2)der

Here we use the hierarchy concept of CPN tools. inc and dcr are substitution transitions and
when fired, they invoke two subpages , inc_# and dcr_#respectively.

Subpages are used to replace the substitution transition inc in order to increment the trans-
mission range whenever the number of neighbours falls short of the threshold value. The
increment is done in steps of 5. The updated transmission range is stored in a place,newrng.
Subpages are used to replace the substitution transition dcr in order to decrement the trans-
mission range whenever the number of neighbours falls short the threshold value. The incre-
ment is done in steps of 5. The updated transmission range is stored in a place,newrng.

fun ChkThreshold(c:INT)=if(c>=2)then tr-5 else tr+-5;

The steps to construct a hierarchical model are:-

1) Move a transition or group to a new submodule.
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»Tool box

Che Binder 0
¥+ Options MsgStore  AH(3) AH(4) AH(5) inc_1 der_1 der 2 inc_2 der 3 inc 3 inc_4 der_4 inc S der 5 AH{1) AH[2)
¥ works.cpn

Step: 0
Time: 0
» Options
» History
¥ Declarations
¥ colset INT=int;
¥var ctr,n,cl: INT;
Tval tr=31;
¥ colset POSITION=
¥var crd:POSITION
¥ colset BOOL=baog
Tvar b:BOOL;
¥ val NoOfNodes=1
¥ colset NODES=im
¥ colset Msg=recor
¥var MSG:Msg;
¥vars,r:NODES;
¥ colset STRIMG=st
Tval A=1"AH(2)++
val B=1"AH(1)++
val C=1"AH(1)++
val D=1"AH(2)++
val E=1" AH(2)++
fun GetDistance(l
fun Update_Cnt()
fun ChkThrashole
fun ChkThreshole
fun ChkThreshole
» Monitors
¥MsgStare
= AH(2)
= AH(3)
TAH(4)
inc_4
der_4
TAH(S)
inc_S
der 5
= AH(1)

ChkThreshold(c)

newrngil, 131

INT

None

Figure 6: Subpage showing transmission range adjustment

2) Replace a substitution transition with its submodule.
3) Assign a submodule to a substitution transition.

4) Assign a port to a socket.

5) Set port type to input.

6) Set port type to output.

7) Set port type to input/output.

8) Assign a place to a fusion set. [4]

For example; if we take node 3: the no. of neighbours=3. Initial transmission range was

31. So now since 3>2 (as used in the simulation , the threshold no. of nodes are 2), hence

new range is 31-5= 26.
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EN CPN Tools (Version 2.2.0 -'S.eptemher
¥Tool box
w Auxiliary Binder 0

S

rCreate MsgStore AH(3) AH(4) AH(5) inc_1 der_1 der_2 inc 2 der 3 inc 3 inc 4 der_4 inc 5 dor 5 AH[1) AH(2)

w Hierarchy
» Monitoring
» Net
» Simulation
» State space
» Style
w\iew
» Help
» Options
¥works.cpn
Step: 80
Time: 0
» Options
» History
¥ Declarations
¥ colset INT=int;
¥var ctr,n,c L INT;
Tvaltr=31;
¥ colset POSITION=
¥var crd:POSITION
¥ colset BOOL=bog
Tvar b:BOOL;
¥val NoOfNodes=1
¥ colset NODES=im

¥ colset Msg=recor 10
¥var MSG:Msqg; /—‘\ il
¥var s,r:NODES;
¥ colset STRING=st
TAH(Z2)++

{se=s,re=rtrange=tr,bp=ncnt=ctr,mb=Ilxc=(# lerd)yc=(#2crd) }

BroadCas

C
DestNode
NODES

GetDistance(#xc MSG, #yc MSG, #1 crd, #.

alculateDistancs

TAH(1)++ =
TAH(1)+4 [step()>B0]
TAH(2)++
val E=1" AH(2)++
fun GetDistance(l
fun Update_Cnt(l
fun ChkThreshale
fun ChkThreshale
fun ChkThreshaole
» Manitors
¥MsgStare
»AH(2)
»AH(Z) Mone
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Figure 7: Counter value of node 3 after simulation is run

EPY CPN Tools (Wersion 2.2.0 - September
¥Tool box
= Auxiliary
»Create Binder 0
» Hierarchy MsgStore  AH(3) AH(4) AH(S) inc_ 1 der 1 der 2
»Monitaring
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Stop
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»Play
»FastForward
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Time: 0
» Options
» History
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¥colset POSITION= proc
wyar crd:POSITION;
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Figure 8: Subpage of node

N

inc. 2 der 2 inc. 2 inc 4 der 4 inc 5 der 5 AH(1) AH(2)

3 showing new transmission range
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fun ChkThreshold{c:INT)=if(c>=2)then tr-5 else tr+5;
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¥MsgStare
¥AH(2)
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der_3
inc_3
VAH(4)
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der_a
YAH(S)
inc_s
der_s
vAH(1)
inc_1
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Figure 9: Codes for declaration of variables and functions used

The Dynamic Transmission Range Adjustment protocol is implemented here using five
nodes. The situation of incrementing the transmission range has been successfully achieved.
The next task towards the validation of the Dynamic Transmission Range Adjustment proto-
col is by validation of the decrementing the transmission range for the same, using Coloured

Petrinet Tool.
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CONCLUSION
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Chapter 5

5 CONCLUSION

Our work is based on ad hoc network which works on static nodes. This can be further ex-
tended to mobile nodes. Validation of this protocol ensures that the self adjusting transmission
range protocol can be implemented in ad hoc network for bringing optimality in the resource
utilization of nodes. It has got variety of application in the field of sensor network as well
and also in emergency situations like natural disasters or military conflicts. The presence of a

dynamic and adaptive routing protocol will enable ad hoc networks to be formed quickly.
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